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2. About this document

2.1. Legend

The following symbols and formats will be used throughout the document.

Important
It gives you important information about the subject.
Please read carefully!

_:OE Hint

It gives you a hint or provides additional information about a subject.

%}\ Example

O It gives you an example of a specific subject.

DS-CAM-600 V21-3 4/32
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3. Key features

The DS-CAM-600 is a high-speed Gigabit-Ethernet camera with following key data:

Up to 600 FPS @ VGA (640x480) or 333 FPS @ 2048 x 1088
Real-time data streaming with full resolution

Monochrome (DS-CAM-600m), color (DS-CAM-600c) and color waterproof (DS-CAM-600cw)
version

Power-over-Ethernet (PoE)

Real-time JPEG compression

Auto-white balance

Triggered and free-run synchronization modes

Adjustable shutter time

Standard C-mount lens mounting

Small compact form factor

Rugged aluminium housing (high shock and vibration resistance)

The camera supports the high-performance industrial standard “GigE Vision”. The standard introduced
in 2006 provides a framework for transmitting high-speed video and related control over Ethernet
networks.

The benefits of the GigE Vision protocol are:

e High speed data transfer rates up to 1GBit/s (based on 1000Base-T),
e Connectible to every standard GigE Ethernet port,
e Cablelengths up to 100m.

DewesoftX® uses OptoStream SDK for communication with cameras that support GigE Vision standard.

Important
For best performance we recommend using a Core i5 CPU or higher performance and at least 4
GB RAM and internal SSD for storing data.

3.1. System Requirements

e 1Gigabit-Ethernet port
High-performance PC (Core i5 CPU or better recommended, 4 GB RAM and high performance
SSD storage disc)
DewesoftX®
The latest OptoStream SDK
Dewesoft GigE driver (cdv)

DS-CAM-600 V21-3 5/32
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4. Technical data

4. Specification

DS-CAM-600 V21-3

Color v
Monochrome v
Color waterproof v
| otiolspecifications |
Image sensor CMOSIS CMV2000 2E5M1PP
Sensor type CMOS
Resolution Up to 2048x1088

331 FPS @ 2048x1088
334 FPS @ 2048x1080

FPS 591 FPS @ 800x600
733 FPS @ 640x480
Sensor size 2/3" (12.7 mm diagonal)
Pixel size (in pm) 55x55
Dynamic range 60 dB
Shutter Electronic Global Shutter
Shutter time 210 ns-90s
Color (DS-CAM-600c¢): v
Autp-white balance Monochrome (DS-CAM-600m): X
Waterproof (DS-CAM-600cw): v/
Picture compression JPEG
| Mechanicalspecifications |
Operating temperature 0 ..+50°C
Operating humidity 25% - 80% (non-condensing)

94 (H) x 54 (W) x 65.5 (D) mm

Dimensions 370 (H) x 213 (W) x 2.22 (D) in

Lens mount C-mount

Connectors Gigabit Ethernet: RJ45, LOOB4f
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CE
EN55022, class A
ENG1000-4-2
ENG1000-4-3
ENG1000-4-4
EN61000-4-6
FCC Part 15, class A RoHS
GigE Vision 1.2

Supply voltage Power-over-Ethernet (42-57V)

Conformity

Power-over-Ethernet v

Power consumption 6WwW
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Illustration 1: Technical drawing of DS-CAM-600
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Illustration 2: L holder for camera mounting.

4.2. Scope of supply

4.2.1. DS-CAM-600 camera versions

The table below describes different variations of DS-CAM-600

DS-CAM-600c Color

DS-CAM-600cw Color waterproof

DS-CAM-600m Monochrome

DS-CAM-600 V21-3
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4.2.2. DS-CAM-600 Accessories

LENS-AZURE-1614MM Azure 1614MM C-MOUNT lens

L holder for perpendicular camera mounting

MOUNT-VERTICAL with 1x 1/4-20 UNC thread

CABLE-LOOB4mM-LO0OB4mM-3m Sync cable for camera synchronization

CABLE-UTP-CAT.6-1M RJ45 CAT 6 cable, for data transfer to PC

Ethernet cable for PoE and data. IP67
connector at camera side.

Cable-CAT. 5E-SF-UTP-IP67-5m

PoE (Power over Ethernet) adapter with
EURO cable

CASE_XTRABAG 300 Carrying bag

POE-LAN-POWER-ADAPTER

Illustration 2: Scope of supply for DS-CAM-600c. Scope of supply for the waterproof version has ruggedized chassis and
waterproof connector types.

4.3. Connections

4.3.1. Connectors and pinout

On the backside of the camera there are two connectors. One for the trigger input (4 pin OB size lemo
-called “1O connector”) and the second one for the data transfer (standard RJ45 ethernet connector).

DS-CAM-600 V21-3 10/32
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Illlustration 2: Connectors on DS-CAM-600

1 - Do not use
2 - Do not use
3 CLK
4 GND

Illustration 3: 1O connector pin-out (4-pin LEMO female)

Interface connector: EEG.00.304.CLL
Mating connector: FGG.00.304.CLAD27Z

ey Hint

,O. Pin 3 and pin 4 are used for clocking the camera. Pins 1 and 2 are reserved for synching multiple

s Dewesoft instruments!

4.3.2. SIRIUS® connection example

The picture below shows a typical camera connection with SIRIUS® (the top slice) and SIRIUS-SBOX (the
bottom slice) instrument is shown..

The camera has to be powered by RJ45 - PoE (Power over Ethernet), therefore a Power injector is
required (Gigabit-LAN port of computer » PoE injector - camera).

DS-CAM-600 V21-3 /32
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The second cable (LOOB4m-LO0B4m-xM) provides the trigger. It is connected to the SYNC port of the
SIRIUS® slice and 1O connector on the DS-CAM-600. With this connection the camera frames will be in
perfect sync with the analog data acquired by DewesoftX®.

., Hint
A
',O: Even if the camera is connected, synching to other SIRIUS® devices is still possible, because
=z there are different pins used on the Sync-Connector for triggering/synching (see also 1O
connector pinout).

-1 L

"f...‘.‘

Illustration 4: SIRIUS S-BOX with SIRIUS® slice on top, connected to the DS-CAM-600 (PoE injector in between)

4.3.3. KRYPTON® connection example

The picture below of a typical camera connection with KRYPTON® device, SYNC Junction and
KRYPTON-CPU is shown.

The camera has to be powered by RJ45 - PoE (Power over Ethernet), therefore a Power injector is
required (Gigabit-LAN port of computer » PoE injector - camera).

The second cable (LOOB4m-LO0B4m-xM) provides the trigger. It is connected to the SYNC port of the
SYNC Junction and IO connector on the DS-CAM-600. With this connection the camera frames will be in
perfect sync with the analog data acquired by DewesoftX® running on the Krypton CPU.

DS-CAM-600 V21-3 12/32
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Illustration 5: KRYPTON® 3xSTG with Sync Junction and Krypton CPU on top, connected to the DS-CAM-600 (PoE injector in
between)

N 1 ’, Hint
ZO: Even if the camera is connected, synching to other Dewesoft devices is still possible, because there
= are different pins used on the Sync-Connector for triggering/synching (see also IO connector
pinout).

DS-CAM-600 V21-3 13/32
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4 4. Resolutions / Framerates

CMV2000

2048 x 1088

STANDARD RESOLUTIONS

Full frame 2.2M 2048 x 1088 331 FPS
2K 2048 x 1088 334 FPS
HD 1080 1920 x 1080 334 FPS
SXGA 1280 x 1024 352 FPS
XGA 1024 x 768 466 FPS
HD 720 1280 x 720 495 FPS
SVGA 800 x 600 591 FPS
PAL 768 x 576 615 FPS
WVGA 752 x 480 733 FPS
VGA 640 x 480 733 FPS
QVGA 320 x 240 1405 FPS

Hint
:< )'_ Results (FPS) should be considered only as approximate MAX values. It depends on the system
- \ /'~ performance (CPU, JPEG compression, harddisk). We recommend to test cameras with your

setup at about 0.8*max_FPS and higher to find where corrupted image, frame loss or buffer
overrun will occur.

DS-CAM-600 V21-3 14/32
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5. Installation

5.1. DewesoftX® full installer

For DewesoftX® all the drivers come with the full installer, if you select the option “GigE camera driver”
during installation. To check if the drivers are installed, go to Options » Installed extensions and see if the
checkbox “GigE" is visible. If not, execute the full installer again, choose the Modify option and enable the
checkbox of GigE camera.

Dewesofti o

Welcome

Modify, repair, or remove the program,

select which options to install for Dewesofty 2020.2.

'ﬁ Madify

t new program features to add or select currently installed features to

4 b |
© remove.

i Repair

Reinstall all program features installed by the previous setup.

-J

i Remove

m Remove all installed features,

DEWESoft

< Back Mext = Cancel

Illustration 6: Installation

The last DewesoftX® full installer can be downloaded here:

https:/download.dewesoft.com/list/dewesoftx

DS-CAM-600 V21-3 15/32
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Dewesofti ot

Select Features

Select the features setup will install.

lect which options to install for Dewesoftx
Dewesoft Jescription
-.[|Dewesoft Launcher

=-[]Extensions

-] cameras

i o] Telemetry camera

GigE camera

["|Exports

-- Visual controls
+-[~]Drivers

+-[#]|External dependendies
+- [ Manuals

DEWESoft

< Back Mext = Cancel

Illustration 7: Installing GigE camera driver

5.2. Manual installation

5.2.1. Required files
OptoStream SDK for GigE Vision

e Go to https://download.dewesoft.com/list/plugins/ and download GigE package
e [tincludesthe latest OptoStream SDK and Dewesoft driver for GigE Vision.

DewesoftX®
e Available from https:/download.dewesoft.com/list/dewesoftx
i, Hint

~ 4
',O: You need to be logged into the Dewesoft website to download the latest development versions
T  of DewesoftX®.

DS-CAM-600 V21-3 16/32
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5.2.2. Step-by-step instruction

Ist step: Install OptoMotive_OptoStreamSDK

Note that you must be an administrator, not just a user with admin rights! Restart the PC after
installation is complete. After reboot be sure that “OptoStream GEM Filter Driver” is installed (picture 1)
under Local area Connection Properties.

e, Hint

,O. Note that “Filter Driver” filters out all packets that are not GigE on hardware level, so the camera
F  will work much faster than without the filter.

U Ethernet Properties et

Metworking  Sharing

Connect using:

I? Irtel(R) Ethemet Connection (6) [215-V

This connection uses the following tems:

£3 Client for Microsoft Networks ~
’:]? File: and Printer Sharing for Microsoft Netwarks

I3 EthercatDAQ Fiter

o aOptoStream GEV Filter Driver
T eBUS Universal Pro For Ethemet Driver
005 Packet Scheduler

4 Intemet Protocol Version 4 (TCP/IPw4) W
£ >

Imstall... Uningtall Properties
Description

MDI56 GigE Vision Fitter Driver

QK Cancel

Illustration 8: Installed OptoStreamViewer GEV Filter Driver.

2nd step: Connect camera to PC via Ethernet cable and PoE Power Injector in between

DS-CAM-600 V21-3 17/32
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3rd step: Assigning IP address to camera

The DS-CAM-600 supports DHCP, so just set your computer's IP address to automatic and wait until the
IP is assigned. To test if the camera is working you can run OptoStreamViewer. By right-clicking on the
camera model you can also set IP to fix, if you prefer.

) OptoStreamViewer - Velociraptor - D0:60:35:33:88:80 - 168.254.135.4 — O X

File VWiew Control Displays Help

BP0 Al ODRED

Devices = 4 P
Model V MAC IP Address

O Velociraptor 00:60:35:33:88:30 169.254.135.4
Device Properties X

Q start

Parameters Device Info Registers

Illustration 9: OK, cameras can be used, close the OptoStreamViewer and start DewesoftX®.

Important
Avoid using OptoStreamViewer and DewesoftX® in parallel.

4th step
To enable the camera in DewesoftX® copy the file “GigeCamera.cdv” into the Dewesoft Addons folder,
usually located in “C\DewesoftX\Bin64\Addons64\GigeCam”.

5th step
Run the "Dewesoft DCOM Registration” to register the plugin.

| = | Bins4 @ Dewesoft DCOM and addons registration {ver. 1.7) *
Home Share Wiew [+*] Addons
« v 4 » ThisPC » Local Disk (C:) » DewesoftX » BinB4 » [] Dewesoft DCOM server
5
A Name [_Regster ]
» 3 Quick access [ canancmlB.dil 3IDModels4, ve OK A
i ADMA_Ethernet.dll OK
> o OneDrive N candbebd.dl ARING_MIL155364.dll OK
Cgoséd.dil ASAM_MDF 464, exp OK
) ASAM_ODS64,exp OK
v B This PC didxd_33_64.dll Attitudelndicators4. ve OK
- . DCOMReg.exe AutoExports4.dil OK
d ". 3D Objects _ BarcodeScannera4.dll OK
5> [ Desktop £ DEWEsoft.exe BrakeNoisea4,dll OK
) D DEWESoft.map BrakeTesto4.mth OK
» % Decuments v = “BWF.exp OK
L rhantar 1064 Al (k0

Illustration 10: OK, cameras can be used, close the OptoStreamViewer and start DewesoftX®

DS-CAM-600 V21-3 18/32
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6th step

Start DewesoftX® and go to Options » Settings » Analog. For triggered mode (DewesoftX® is clocking
the camera), check if your device (such as DEWE-43 for example) is set to Automatic or Clock/Trigger:

O *
Operation mode |RJ.=_aI measurement ~ |
@ 0 @ Synchronization
v {2} Local system Time source Dewesoft DAQ Devices ~ |
v - Dewesoft Devices & )
{0 e Dewe-43 DZESO E_':::EQ Devices Clock/Trigger @
w .‘ GigE C prowvider
il DS-CAM - Velodiraptor Standalone
L Clock/Trigger
Setti
© Settings IRIG-B DC
Illustration 11: Options » Settings: Set device to Automatic (Standalone) or Clock/Trigger
7th step
Go to the GigE tab and set “Use trigger”.
A\ Settings for project: default O x
Operation mode Real measurement w
@ Extensions @ e 0 Found 1 camera(s)
MNo. ‘ Mame | Enabled | Camera status: device is connected
E Global variables ¥ --e":a;::s:::& Devices 1} DS-CAM - Velodraptor Yes A 1P address:
% Data header o = [ oHee Subnet mask:
Subnet mask is ok
o Startup DA ecraptor |:| PermanentIP  Gateway:
W peromance
CD User interface
B Files and folders
E Storing
@ Reports
a Security
@ Update v [ Use trigger I

Illustration 12: DewesoftX® hardware setup, add GigE.

“File format” should be set to “DVI” which is uncompressed DewesoftX® video format. The CPU will not
have enough power to additionally do the “live” compression. Depending on the measurement duration,
the video file can get very big. For compression after the measurement set the appropriate compressor
in “AVI file type for compression”. We recommmend downloading the XVID codec. In Analysis mode you
can then select your datafile and click “AVI compress”.

DS-CAM-600 V21-3 19/32
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Dewesoftx

Analyze Data fles  Setup  Review

Am

Measure

- O et
= Options
* ) ——— :"
F @ O & || = @ 3 W 0O [ @
Import  Multifle export Apply action Use for measure Revert to orig) AVI compress |Post-sync. video Load Rename Delete
S5 E— O
Data

+ File name Size
'y

= Example drive.dxd

Copy Cut Paste

Version

2,1MB %3 5P11(RELEASE-200418) (64-bit)  ©
750kB 2020, 1 {RELEASE-200922) (64-bit)

Illustration 13: AVI compress after measurement

8th step
Go to Ch. Setup, click the Video tab, click the Unused button to enable the video channel.

= H ++ I
. = = . nlpU - mi
Store Save Save as Storing Analog in Video Math More., .. Remove
Camera options
Store options Frame rate
‘always fast v (250 v]
ID |C Lsed Channel name | Camera name | Camera status | Setup
0 Camera 0 | DS-CAM - Velodraptor | Frame rate: 250,00 fps Setup

Illustration 14: DewesoftX® Channel setup » add Video
1, Hint

~ L4
',O: Ensure the firmware version of Dewesoft hardware is up to date, otherwise follow the
= instructions of how to do it in the Updating firmware article.

DS-CAM-600 V21-3 20/32
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9th step

Enter the channel setup. By now, already a picture should be shown.

Camera 0 (DS-CAM - Velociraptor)

General || Advanced »
Camera name Camera 0

Color

Preview - 250,0 fps/ 3,9 MB/s

Camera settings

Resolution

540 x 480 ~
Frame rate

|250,00

Cunlock frame rate limits

framess (Max: 500,00)

Shutter
[ ] 1000,00 us
Gain
v 1,00
Automatic shutter Off ~
Automatic white balance | Off w
IPEG quality i

[High dynamic range (HDR) l:l %

[ optimize for switched network Packet size: 1500 Kb

Advanced setup...

[ o ]

Illustration 15: DewesoftX® video channel setup

e The shutter bar determines the light exposure duration (brightness).
e Ifthelightistoo dark, use the gain bar to increase brightness by software.

e The JPEG quality is inversely to the compression. 80% means good quality, low compression.

Automatic shutter Off

Automatic white balance | Off

JPEG quality

CI

[ ]High dynamic range (HDR)

0 %o

[ | Optimize for switched network

Advanced setup...

Illustration 16: Poor and good picture quality

e \With the HDR option you are able to increase the dynamic from 60 up to 120dB if you have an
image with low dynamic range (e.g. only light grey and dark grey shapes).

e Toimprove the performance if using the camera on an Ethernet switch, use “Optimize for

switched network”

DS-CAM-600 V21-3
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e Use the “Advanced Setup”, if you want to change specific parameters of the camera, such as the
custom resolution and AQOI, area of interest, for instance.

., Hint

sfae

:O: If you change the frame rate, after typing the value, the input field gets a yellow color; confirm
z the value by pressing the Enter key.

6. Troubleshooting guide

GigE checkbox in Settings is missing

Go to My Computer and click System properties » Advanced system settings » Advanced tab -»
Environment Variables » System variables » select Path » Edit.

Make the following changes:

e %OPTOSTREAM_SDK_PATH%\bin
e %GENICAM_ROOT_V2_4_ARCH%\bin\Windows
e %GENICAM_ROOT_V2_4_ARCH%\bin\Windows \GenApi\Generic

Save and reset Windows. Path correctness can be checked by GetEnvironmentVariable('PATH');

No picture shown, “No frames received” error
If you receive the error “NO FRAMES RECEIVED”, check: -

Is the Trigger/Sync cable connected?

Try decreasing the Shutter value

Check in Settings if the DewesoftUSB device is set to Clock/Trigger or Automatic (Standalone)
Disable Trigger in hardware setup and check if it's working in free-run mode (This could
potentially be a cable problem. Swap in new cables and try again)

Camera not found (not in OptoStreamViewer, not in DewesoftX®)

Check if the status LED on the camera is green, booting takes ABOUT 1 MINUTE!
If using a GigE-Switch with PoE ports, ensure output power is sufficient, check status LED during
operation

e Check Windows Firewall settings

Camera not found (not found in DewesoftX®; yellow mark in OptoStreamViewer)

Not able to use the cameras. Please wait a little bit (until IP is assigned). If that does not help, ensure the
computer's network IP is set to automatic, as the camera supports DHCP.

DS-CAM-600 V21-3 22/32
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Further troubleshooting, most probably the computer and the camera are not in the same subnet.

o OptoStreamViewer (Warning: OptoMotive Filter Driver not loaded.)

File View Control Displays Help

Baen pgBE aaalfl ADRE
& X

Devices

Model N MAC IP Address
A Velociraptor  00:60:35:33:88:80 160.254.135.4

lllustration 16: IP address problem

Important
You should avoid using OptoStreamViewer and DewesoftX® in parallel. If the cameras are
found, close DewesoftX® restart OptoStreamViewer.

Change IP address of the camera

o OptoStreamViewer (Warning: OpteMotive Filter Driver not loaded.) - Velociraptor - 0060

File View Control Displays Help

wBe PO el 0D E

Devices f X

o

Model MALC IP Address
€) Velocirapter  00:60:3%:33:88:30 160.254.135.4

‘W@ Connect Device

“@ Disconnect Device

E Set Ip To Device

““  Find Devices

Illustration 17: Change IP address of the camera

If you manually change the IP address, please use the same subnet as the computer, example:
PC:169.254.135.5, Subnet 255.255.255.0

Camera: 169.254.135.4, Subnet 255.255.255.0

DS-CAM-600 V21-3 23/32
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The IP is ok, if the cameras are found with a red mark (see lllustration above), close OptoStreamViewer
and start DewesoftX®.

GigEVision client does not start, error message when starting

Troubleshoot this using the following steps: Check if the operating system of your computer is 32bit or
64bit.

Copy the 64-bit dlls (otherwise take the ones from the 32bit directories) from
C\Program Files\OptoMotive\OptoStreamSDK\bin\Win64 and

C\Program Files\OptoMotive\OptoStreamSDK\GenlCam_v2_4\bin\Win64_x64 to
\Windows\system32 (respectively \Windows\SysWOW64)

Then start the OptoStreamViewer from C\Program Files\OptoMotive\OptoStreamSDK\bin\Win64

Cameras not working in DewesoftX®

If you followed the step-by-step installation procedure, but still the camera is not working in
DewesoftX®, you can try to copy the used dlls manually:

Copy the 32-bit dlls from
C\Program Files\OptoMotive\OptoStreamSDKbin\Win32
and
C\Program Files\OptoMotive\OptoStreamSDK\GenlCam_v2_4\bin\Win32_i86
to
Dewesoft's Addons folder.
Then restart DewesoftX®.
Performance improvements (e.g. in case of frames lost or buffer overrun)
A loss of a few frames during a measurement is normal, due to collisions on the Ethernet network.
Here are some useful hints to improve the performance:

e Do not operate the camera in a fully loaded network (e.g. office computers). Just use direct
connection or one switch (with no additional participants).
Disable all anti-virus, firewall, indexing and synchronization programs running in background.
Verify that the PC has a Gigabit-Ethernet network card, not only 100Mbit/s.
o Check this in Device Manager tools
e Verify that the LAN cable being used between the camera and the PC is at least CAT5 quality. For
longer cable lengths CAT6 cable should be used for optimal performance.

DS-CAM-600 V21-3 24/32
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Store

18]

@ Video

LU B I - L B =

For this camera, the best quality can be achieved by using a powerful CPU.
Try to decrease the JPEG compression (e.g. from 80 down to 50%)
Use the Windows resource monitor (can be found in Task manager) to check for bottlenecks.

o Check CPU and RAM
For optimal performance we recommend enabling “Jumbo” frames on your PC network card.
“Jumbo” frames are Ethernet packets larger than 1500 bytes. This way less CPU time is spent for
data reception therefore increasing performance and minimizing data loss. (Control panel »
network and internet » view network status and tasks (network and sharing center) » change
adapter settings » right-mouse-click on LAN connection » Properties » Configure » Advanced -
Jumbo Frame - set to highest value (e.g. 9kB MTU))
Also an overloaded DewesoftX® setup (many displays, e.g. high resolution FFT instruments) will
take system power. Try at first only with camera video instruments.
Press <Ctrl>+<Shift>+<P> in DewesoftX® Measure mode. On the right side the performance
monitor will appear. Watch the Cam video buffer. It should stay stable at low values.
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Illustration 18: DewesoftX® Performance monitor
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6.1. Reference list

(a) Velociraptor HS: https:.//www.optomotive.com/category/velociraptor-hs

(b) SIRIUS® Technical manual:
https://download.dewesoft.com/download-file/dewesoft-sirius-manual-enpdf
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7. Warranty information

Notice
The information contained in this document is subject to change without notice.

Note:

Dewesoft d.o.o. shall not be liable for any errors contained in this document. Dewesoft MAKES NO
WARRANTIES OF ANY KIND WITH REGARD TO THIS DOCUMENT, WHETHER EXPRESS OR IMPLIED.
DEWESOFT SPECIFICALLY DISCLAIMS THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE. Dewesoft shall not be liable for any direct, indirect, special, incidental, or
consequential damages, whether based on contract, tort, or any other legal theory, in connection with
the furnishing of this document or the use of the information in this document.

The copy of the specific warranty terms applicable to your Dewesoft product and replacement parts can
be obtained from your local sales and service office. To find a local dealer for your country, please visit

https:/dewesoft.com/support/distributors.

7.]1. Calibration

Every instrument needs to be calibrated at regular intervals. The standard norm across nearly every
industry is annual calibration. Before your Dewesoft data acquisition system is delivered, it is calibrated.
Detailed calibration reports for your Dewesoft system can be requested. We retain them for at least one
year, after system delivery.

'7.2. Support

Dewesoft has a team of people ready to assist you if you have any questions or any technical difficulties
regarding the system. For any support please contact your local distributor first or Dewesoft directly.

Dewesoft d.o.o.
Gabrsko 11a
1420 Trbovlje Slovenia

Europe Tel.: +386 356 25 300

Web: http:/www.dewesoft.com
The telephone hotline is available Monday to Friday from 07:00 to 16:00 CET (GMT +1:00)

7.3. Service/repair

The team of Dewesoft also performs any kinds of repairs to your system to assure a safe and proper
operation in the future. For information regarding service and repairs please contact your local

distributor first or Dewesoft directly on https:/dewesoft.com/support/rma-service.
7.4. Restricted Rights

Use Slovenian law for duplication or disclosure. Dewesoft d.o.o. Gabrsko 11a, 1420 Trbovlje, Slovenia /
Europe.
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7.5. Printing History
Version 2.0.0, Revision 217 Released 2015 Last changed: 23. July 2018 at 16:54.

7.6. Copyright

Copyright © 2015-2019 Dewesoft d.o.0. This document contains information which is protected by
copyright. All rights are reserved. Reproduction, adaptation, or translation without prior written
permission is prohibited, except as allowed under the copyright laws. All trademarks and registered
trademarks are acknowledged to be the property of their owners.

7.8. Trademarks

We take pride in our products and we take care that all key products and technologies are registered as
trademarks all over the world. The Dewesoft name is a registered trademark. Product families
(KRYPTON, SIRIUS, DSI, DS-NET) and technologies (DualCoreADC, SuperCounter, GrandView) are
registered trademarks as well. When used as the logo or as part of any graphic material, the registered
trademark sign is used as a part of the logo. When used in text representing the company, product or
technology name, the ® sign is not used. The Dewesoft triangle logo is a registered trademark but the ®
sign is not used in the visual representation of the triangle logo.

8. Safety instructions

Your safety is our primary concern! Please be safe!

8.1. Safety symbols in the manual

Warning
Calls attention to a procedure, practice, or condition that could cause the body injury or death

QA7 Caution
_/l\_ Calls attention to a procedure, practice, or condition that could possibly cause damage to
equipment or permanent loss of data.

8.2. General Safety Instructions

. Warning

The following general safety precautions must be observed during all phases of operation, service, and
repair of this product. Failure to comply with these precautions or with specific warnings elsewhere in
this manual violates safety standards of design, manufacture, and intended use of the product.
Dewesoft d.o.o. assumes no liability for the customer’s failure to comply with these requirements.
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All accessories shown in this document are available as an option and will not be shipped as standard
parts.

8.2.1. Environmental Considerations

Information about the environmental impact of the product.

8.2.2. Product End-of-Life Handling

Observe the following guidelines when recycling a Dewesoft system:

8.2.3. System and Components Recycling

Production of these components required the extraction and use of natural resources. The substances
contained in the system could be harmful to your health and to the environment if the system is
improperly handled at its end of life! Please recycle this product in an appropriate way to avoid
unnecessary pollution of the environment and to keep natural resources.

This symbol indicates that this system complies with the European Union’s requirements
according to Directive 2002/96/EC on waste electrical and electronic equipment (WEEE).
Please find further information about recycling on the Dewesoft web site www.dewesoft.com

I Restriction of Hazardous Substances
This product has been classified as Monitoring and Control equipment and is outside the
scope of the 2002/95/EC RoHS Directive. However, we take care of our environment and the product is
lead-free.

8.2.4. General safety and hazard warnings for all Dewesoft systems

Safety of the operator and the unit depend on following these rules.

Use this system under the terms of the specifications only to avoid any possible danger.

Read your manual before operating the system.

Observe local laws when using the instrument.

DO NOT touch internal wiring!

DO NOT use higher supply voltage than specified!

Use only original plugs and cables for harnessing.

You may not connect higher voltages than rated to any connectors.

The power cable and connector serve as Power-Breaker. The cable must not exceed 3 meters, the

disconnect function must be possible without tools.

Maintenance must be executed by qualified staff only.

During the use of the system, it might be possible to access other parts of a more comprehensive

system. Please read and follow the safety instructions provided in the manuals of all other

components regarding warning and security advice for using the system.

With this product, only use the power cable delivered or defined for the host country.

DO NOT connect or disconnect sensors, probes or test leads, as these parts are connected to a

voltage supply unit.

e GCround the equipment: For Safety Class 1 equipment (equipment having a protective earth
terminal), a non-interruptible safety earth ground must be provided from the mains power
source to the product input wiring terminals.
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e Please note the characteristics and indicators on the system to avoid fire or electric shocks.
Before connecting the system, please read the corresponding specifications in the product
manual carefully.

e The inputs must not, unless otherwise noted (CATx identification), be connected to the main
circuit of category I, lll and IV.

e The power cord separates the system from the power supply. Do not block the power cord, since
it has to be accessible for the users.

DO NOT use the system if equipment covers or shields are removed.

If you assume the system is damaged, get it examined by authorized personnel only.

Adverse environmental conditions are Moisture or high humidity Dust, flammmable gases, fumes
or dissolver Thunderstorm or thunderstorm conditions (except assembly PNA) Electrostatic
fields, etc.

The measurement category can be adjusted depending on module configuration.

Any other use than described above may damage your system and is attended with dangers like
short-circuiting, fire or electric shocks.

The whole system must not be changed, rebuilt or opened.

DO NOT operate damaged equipment: Whenever it is possible that the safety protection features
built into this product have been impaired, either through physical damage, excessive moisture,
or any other reason, REMOVE POWER and do not use the product until the safe operation can be
verified by service-trained personnel. If necessary, return the product to Dewesoft sales and
service office for service and repair to ensure that safety features are maintained.

e If you assume a more riskless use is not provided anymore, the system has to be rendered
inoperative and should be protected against inadvertent operation. It is assumed that a more
riskless operation is not possible anymore if the system is damaged obviously or causes strange
noises. the system does not work anymore. The system has been exposed to long storage in
adverse environments. the system has been exposed to heavy shipment strain.

e \Warranty void if damages caused by disregarding this manual. For consequential damages, NO
liability will be assumed!

e Warranty void if damage to property or persons caused by improper use or disregarding the
safety instructions.

e Unauthorized changing or rebuilding the system is prohibited due to safety and permission
reasons (CE).

e Be careful with voltages >25 VAC or >35 VDC! These voltages are already high enough in order to
get a perilous electric shock by touching the wiring.

e The product heats during operation. Make sure there is adequate ventilation. Ventilation slots
must not be covered!

e Only fuses of the specified type and nominal current may be used. The use of patched fuses is
prohibited.

Prevent using metal bare wires! Risk of short circuit and fire hazard!

DO NOT use the system before, during or shortly after a thunderstorm (risk of lightning and high
energy over-voltage). An advanced range of application under certain conditions is allowed with
therefore designed products only. For details please refer to the specifications.

e Make sure that your hands, shoes, clothes, the floor, the system or measuring leads, integrated
circuits and so on, are dry.

e DO NOT use the system in rooms with flammmable gases, fumes or dust or in adverse
environmental conditions.

e Avoid operation in the immediate vicinity of high magnetic or electromagnetic fields,
transmitting antennas or high-frequency generators, for exact values please refer to enclosed
specifications.
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e Use measurement leads or measurement accessories aligned with the specification of the
system only. Fire hazard in case of overload!

e Do not switch on the system after transporting it from a cold into a warm room and vice versa.
The thereby created condensation may damage your system. Acclimatise the system unpowered
to room temperature.

e Do not disassemble the system! There is a high risk of getting a perilous electric shock.
Capacitors still might be charged, even if the system has been removed from the power supply.

e The electrical installations and equipment in industrial facilities must be observed by the security
regulations and insurance institutions.

e The use of the measuring system in schools and other training facilities must be observed by
skilled personnel.

The measuring systems are not designed for use in humans and animals.
Please contact a professional if you have doubts about the method of operation, safety or the
connection of the system.

e Please be careful with the product. Shocks, hits and dropping it from already- lower level may
damage your system.

e Please also consider the detailed technical reference manual as well as the security advice of the
connected systems.

e This product has left the factory in safety-related flawlessness and in proper condition. In order to
maintain this condition and guarantee safety use, the user has to consider the security advice
and warnings in this manual.

EN 61326-3-1:2008
IEC 61326-1 applies to this part of IEC 61326 but is limited to systems and equipment for industrial
applications intended to perform safety functions as defined in IEC 61508 with SIL 1-3.

The electromagnetic environments encompassed by this product family standard are industrial, both
indoor and outdoor, as described for industrial locations in IEC 61000-6-2 or defined in 3.7 of IEC 61326-1.

Equipment and systems intended for use in other electromagnetic environments, for example, in the
process industry or in environments with potentially explosive atmospheres, are excluded from the

scope of this product family standard, |IEC 61326-3-1.

Devices and systems according to |[EC 61508 or |IEC 61511 which are considered as “operationally
well-tried”, are excluded from the scope of IEC 61326-3-1.

Fire-alarm and safety-alarm systems, intended for the protection of buildings, are excluded from the
scope of |IEC 61326-3-1.
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9. Documentation Version

1.0.0 23.02.2013 Initial revision
V20-1 23.9.2020 New template and new screenshots.
V20-2 12.10.2020 SDK versions is changed to OptoStream SDK
V21-1 11.1.2021 Temporarily deleted chapter
V21-2 10.05.2021 Updated standard resolutions table
V21-3 26.11.2021 4.1. Specification
e Modified to 591 FPS @ 800x600
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